Trademarks

The following are trademarks of Motorola: MOTOTRBO™.

Any other brand or product names are trademarks or registered trademarks of their respective holders.

The Genesis Group Trademark Information

GW3-TRBO® is a registered trademark of GenCore Candeo, LTD., a subsidiary of Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks.

Copyright

Copyright © 2006-2020; Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks. All rights are reserved. No part of this publication or the associated program may be reproduced, transmitted, transcribed, in whole or in part, in any form or by any means, whether it is mechanical, magnetic, optical, electronic, manual or otherwise, without the prior written consent of Burks GenCore Co., Inc. D.B.A: The Genesis Group and Phil Burks

5800 Eagles Nest Blvd
Tyler, Texas 75703.

Includes technology licensed from Motorola.

Disclaimer

The GW3-TRBO User’s Manual is printed in the U.S.A. Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks believe that the information included in this manual is correct; however, Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks reserves the right to alter, revise and make periodic changes to the manual and its contents. Burks GenCore Co., Inc. D.B.A. The Genesis Group does not assume responsibility to notify any person of such revisions or changes. While we have taken strides to carefully examine our software and documentation and believe that it is reliable, the Genesis Group and Phil Burks assume no responsibility for the use of the manual, or GW3-TRBO software, nor for any patent infringements or other rights of third parties who may use the manual or the GW3-TRBO software. Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks make no representations or warranties with respect to the contents or fitness for a particular purpose beyond the cost of the software paid by the end-user.

The software contains valuable trade secrets and proprietary information. Unauthorized use of the manual or software can result in civil damages and criminal prosecution. As an end user, you agree to abide by and heed these statements.

License

Title to the media on which the program is recorded and to the documentation in support of the product is transferred to you, but title to the program, and all subsequent copies of the program, despite the form or media in or on license is not a sale of the original or any subsequent copy. You assume responsibility for the selection of the program to achieve your intended results, and for the installation, use, and results obtained from the program.

Refer to the GW3-TRBO Manual Overview for your full license. All license information contained on pages 4-7 (Book 600-2.16.15-AA.1) are to be considered as contained herein.

Support

Customer satisfaction is our number one priority at Genesis. We are here to provide you with the best software possible, and we want to know when you have any questions, concerns or problems with GW3-TRBO so that we can make it a better product for everyone.

Refer to the Troubleshooting & Support section of the GW3-TRBO Manual Shell (Book 600-2.16.15-AA.1) for complete support and contact information.
# Document History

<table>
<thead>
<tr>
<th>Revision</th>
<th>Description</th>
<th>Author</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0.5</td>
<td>Initial Release</td>
<td>JAW</td>
</tr>
<tr>
<td>2.0.5</td>
<td>Replaced GW3-TRBO trademark with registered trademark.</td>
<td>JAW</td>
</tr>
<tr>
<td>2.0.6</td>
<td>Console Window</td>
<td>KIH</td>
</tr>
<tr>
<td>2.0.6</td>
<td>Added System Map View</td>
<td>REB</td>
</tr>
<tr>
<td>2.0.6</td>
<td>Updated Figures 2.7, 2.11, 2.13, 2.15, 2.16, 2.17 and 2.20.</td>
<td>REB</td>
</tr>
<tr>
<td>2.0.6</td>
<td>Removed Console Window</td>
<td>REB</td>
</tr>
<tr>
<td>2.0.6</td>
<td>Updated Figures 1.1, 2.6, 2.8, 2.10, System Header, Zone Header, Site Header</td>
<td>CLB</td>
</tr>
<tr>
<td>2.0.6</td>
<td>Added description of multislot functionality</td>
<td>REB</td>
</tr>
<tr>
<td>2.0.6</td>
<td>Updated Options section</td>
<td>WRK</td>
</tr>
<tr>
<td>2.0.6.6</td>
<td>Documentation Review</td>
<td>REB</td>
</tr>
<tr>
<td>2.0.6.9</td>
<td>Added multisite call info for IPSC.</td>
<td>REB</td>
</tr>
<tr>
<td>2.0.6.11</td>
<td>Removed Add Expected Channels option</td>
<td>REB</td>
</tr>
<tr>
<td>2.1</td>
<td>Revisions for Release</td>
<td>WRK</td>
</tr>
<tr>
<td>2.2</td>
<td>Added Local/Wide indicator to System Map</td>
<td>REB</td>
</tr>
<tr>
<td>2.2</td>
<td>Updated screenshots</td>
<td>WRK</td>
</tr>
<tr>
<td>2.3</td>
<td>Revision before release</td>
<td>CWF</td>
</tr>
<tr>
<td>2.4</td>
<td>Revision Before Release</td>
<td>CWF</td>
</tr>
<tr>
<td>2.4</td>
<td>Revised System Map</td>
<td>REB</td>
</tr>
<tr>
<td>2.5</td>
<td>Revisions before release</td>
<td>CWF</td>
</tr>
<tr>
<td>2.5</td>
<td>Updated Statistics window screenshot with Slots</td>
<td>REB</td>
</tr>
<tr>
<td>2.5</td>
<td>Updated Systems Panel Data Section</td>
<td>CWF</td>
</tr>
<tr>
<td>2.5</td>
<td>Updated Statistics with Airtime Information</td>
<td>KIH</td>
</tr>
<tr>
<td>2.6</td>
<td>Revisions Before Release</td>
<td>CWF</td>
</tr>
<tr>
<td>2.7</td>
<td>Updated Various Screen Shots</td>
<td>CWF</td>
</tr>
<tr>
<td>2.7</td>
<td>Added Slot 1 Type and Slot 2 Type columns to System Map</td>
<td>REB</td>
</tr>
<tr>
<td>2.8</td>
<td>Revisions Before Release</td>
<td>ATG</td>
</tr>
<tr>
<td>2.8</td>
<td>Added Controller peer type to description of System Map.</td>
<td>REB</td>
</tr>
<tr>
<td>2.9</td>
<td>Revisions Before Release</td>
<td>REB</td>
</tr>
<tr>
<td>2.9</td>
<td>Removed obsolete note about Offline channels.</td>
<td>REB</td>
</tr>
<tr>
<td>2.10</td>
<td>Added MNIS to list of peer types and updated Slot Type description in the System Map section.</td>
<td>REB</td>
</tr>
<tr>
<td>2.10</td>
<td>Revisions Before Release</td>
<td>REB</td>
</tr>
<tr>
<td>2.10</td>
<td>Added Virtual Peer and Application peer types to System Map.</td>
<td>REB</td>
</tr>
<tr>
<td>2.10</td>
<td>Removed Controller peer type due to changes in R2.3 firmware.</td>
<td>REB</td>
</tr>
<tr>
<td>2.11</td>
<td>Converted to Docx format</td>
<td>CWF</td>
</tr>
<tr>
<td>2.11</td>
<td>Added description of new System Map customization features.</td>
<td>REB</td>
</tr>
<tr>
<td>2.12</td>
<td>Revisions Before Release</td>
<td>JAW</td>
</tr>
<tr>
<td>2.12</td>
<td>Added Reject Reason Information section.</td>
<td>REB</td>
</tr>
<tr>
<td>2.13</td>
<td>Revisions Before Release</td>
<td>ATG</td>
</tr>
<tr>
<td>2.14</td>
<td>Revisions Before Release</td>
<td>JAW</td>
</tr>
<tr>
<td>2.15</td>
<td>Revisions Before Release</td>
<td>REB</td>
</tr>
<tr>
<td>-----</td>
<td>------------------------</td>
<td>-----</td>
</tr>
<tr>
<td>2.16</td>
<td>Revisions Before Release</td>
<td>JPS</td>
</tr>
<tr>
<td>2.16</td>
<td>Added Data Revert section</td>
<td>JPS</td>
</tr>
<tr>
<td>2.16</td>
<td>Updated Active Resource Description</td>
<td>KIH</td>
</tr>
</tbody>
</table>
# Table of Contents

- Trademarks .................................................................................................................... 3  
- The Genesis Group Trademark Information ................................................................. 3  
- Copyright ....................................................................................................................... 3  
- Disclaimer ...................................................................................................................... 3  
- License .......................................................................................................................... 3  
- Support .......................................................................................................................... 3  
- DOCUMENT HISTORY ................................................................................................. 4  

## TABLE OF CONTENTS ................................................................................................. 7  

## ABOUT THIS MANUAL ............................................................................................... 9  
- GOALS .......................................................................................................................... 9  
- WHO SHOULD READ THIS MANUAL? ....................................................................... 9  
- HOW THIS MANUAL IS ORGANIZED ....................................................................... 9  

## CHAPTER 1 OVERVIEW .......................................................................................... 11  
- WHAT IS CHANNEL? .................................................................................................... 11  

## CHAPTER 2 USING CHANNEL .................................................................................. 13  
- POSITIONING CHANNELS ........................................................................................ 13  
- UNDERSTANDING CHANNEL STATUS DATA ....................................................... 14  
- Information Pane ......................................................................................................... 14  
- Systems Panel Data ...................................................................................................... 15  
- Reject Reason Information ............................................................................................ 16  
- Diagnostics Panel Data .................................................................................................. 17  
- Busies Panel Data .......................................................................................................... 18  
- Color Legend .................................................................................................................. 19  
- Sounds Button ............................................................................................................... 20  
- Menus ............................................................................................................................. 21  
- View ............................................................................................................................... 21  
- Edit ................................................................................................................................ 21  
- Help .................................................................................................................................. 22  
- Channel Options ............................................................................................................. 23  
- SYSTEM ACTIVITY VIEW .......................................................................................... 26  
- System Header ............................................................................................................... 26  
- Zones Menu ..................................................................................................................... 26  
- Sites Menu ....................................................................................................................... 26  
- Zone Header .................................................................................................................... 27  
- Sites Menu ....................................................................................................................... 27  
- Site Header ...................................................................................................................... 28  
- Statistics ......................................................................................................................... 29  
- Site Idle Interval ............................................................................................................. 32  
- Channel Activity ............................................................................................................. 33  
- Radio Commands ........................................................................................................... 33  
- Slotted Activity ............................................................................................................... 34  
- Data Revert ..................................................................................................................... 34  
- APM Data Supplementation ........................................................................................... 35  
- Systems with large numbers of channels ...................................................................... 36  
- Packet Information Window .......................................................................................... 37  
- Threshold Lights ............................................................................................................ 38  
- Example Thresholds ....................................................................................................... 38  
- Threshold Alerts panel ................................................................................................. 39
Goals
This manual describes the role and function of the Channel module and graphical user interface (GUI) in the GW3-TRBO solution.

Who Should Read This Manual?
This manual is written for an intended audience of novice to mid-level MOTOTRBO system users and novice to mid-level PC users.

How This Manual Is Organized
This manual is organized as follows:

- **Overview**: Defines the Channel GUI and the organization of the channel information.
- **Using Channel**: provides instructions on reading the Channel data and setting up the GUI to satisfy your viewing needs.

This manual contains the following images, used to indicate that a segment of text requires special attention:

- **Additional Information**: Additional information is used to indicate shortcuts or tips.
- **Warning**: Warnings are used to indicate possible problem areas, such as a risk of data loss, or incorrect/unexpected functionality.
This chapter defines the Channel GUI and the organization of the channel information.

This chapter contains the following sections:

- **What is Channel?**: Defines the Channel GUI.

### What is Channel?

The Channel GUI displays real-time, decoded channel activity, diagnostics and busies. The Channel GUI displays activity for each channel on individual virtual repeater channel blocks. The diagnostics, busies and reject reasons are shown in their own respective lists on the left side of the GUI.

**This GUI’s information is volatile.** This means that if you close this GUI, Channel will not save the information in the Diagnostics and Busies lists or any information in the channel monitors.

**Channel resources, such as systems, zones, sites and channels, reflect the changes made to these resources in the Alias module.** For example, if you change a site’s alias in Alias, Channel will reflect this change. These changes may take up to 30 seconds to take effect in the Channel GUI.

![Figure 1.1 – Channel GUI](image)
Chapter 2  Using Channel

This chapter provides instructions on understanding the Channel data and setting up the GUI to satisfy your viewing needs.

This chapter contains the following sections:
- **Positioning Channels**: Describes how to position channels within a site.
- **Understanding Channel Status Data**: Describes each type of data displayed in the Channel GUI.
- **System Activity View**: Describes each section of the real-time system, zone, site and channel-based display.

**Positioning Channels**

This section references setup processes in the Alias GUI. Please refer to the *Alias Module Book* for instructions on using the Alias GUI.

The Channel GUI works best when all of a system’s channels exist in the Alias module.

![Site Options](image)

**Figure 2.1 – Dynamically Add Channels Option in Alias GUI**

By default, the channels in the Channel GUI will display in order of the channel’s key type (frequency or position). The channel’s key type is determined by the **Channel Key Type** of the channel’s site.

The **Use Channel Aliases in Header** option in the Channel GUI allows you to choose to sort these channels by the channel’s alias instead (see the *Channel Options* section of this document for more details).
Three common patterns you can use to optimally display channels in the Channel GUI are:

- **Position based**: On a system with 11 channels, the primary control channel could be assigned alias 01 and the least active dispatch activity channel could be assigned alias 11. The first position needs to have a leading zero because alias sorting would put 11 before 2.

- **Frequency based**: To sort by frequency set the alias to the frequency number of each channel. Frequencies are generally the same length and will not have to be padded with zero values.

- **Position and Frequency based**: To sort by Position and frequency set the alias in the following format xx yyyyyyyyy where xx is the position and yyyyyyyyy is the frequency.

**Understanding Channel Status Data**

The Channel GUI displays a vast amount of information. This information is organized and displayed in the following areas:

- **Information Pane**: Shows the currently selected system and any diagnostics and busies.

- **Activity Panel**: Shows site-based channel blocks when a site is checked in the **Systems** panel.

**Information Pane**

The Information Pane contains multiple panels that may be resized or collapsed as desired. In addition to these panels, the Information Pane also contains the Sounds button.

- **Systems Panel**: Shows each system, zone and site that currently exists in the Alias database.

- **Diagnostics**: Show real-time diagnostic information here as it is received.

- **Busies Panel**: Shows real-time busy activity as it occurs.
**Systems Panel Data**

The *Systems* panel (Figure 2.2) shows the tree of known system resources that pertain to the channel hierarchy. In this hierarchy:

- Zones exist under systems
- Sites exist under zones
- Channels exist under sites

This tree structure displays this hierarchy down to the site level. To display channels on a site, check the box next to the site in the *Systems* panel’s resource tree. To view this activity at the zone level, check the box next to a zone.

![Figure 2.2 – Systems Panel Resource Tree](image)

The checkboxes beside the parent structures in the tree for zones and sites can be checked or unchecked to select all the subitems (zones and sites). The checkbox next to the *Systems* node is used to expand or collapse all subitems (systems, zones and sites). The checkbox next to the system (WACN:System) is used to select the system you wish to view in the *Activity* panel.
Reject Reason Information

The **Radio Rejects** button is near the middle-left of the Channel GUI. Click this button to show radio rejects on this section of the window (Figure 2.3). The reject reasons list shows each reject reason that has appeared on the system since the Channel GUI was opened. Each reject reason in the list contains the following information:

- **System**: The WACN and system on which the rejection occurred.
- **Zone**: The zone on which the rejection occurred.
- **Site**: The site on which the rejection occurred.
- **Talkgroup**: The talkgroup on which the rejection occurred.
- **ID**: The ID that was rejected.
- **Target ID**: The ID targeted by the activity that was rejected.
- **Reason**: The reported reason the rejection occurred.
- **Rejectee**: Identifies what was rejected.
- **Timestamp**: The last date and time the rejection occurred.
- **Count**: The number of times this rejection has occurred.

![Radio Rejects List](image)

**Figure 2.3** – Radio Rejects List

Right-clicking on the **Radio Rejects** panel will cause a context menu to be shown, with options to print the rejects or clear selected rejects.
Diagnostics Panel Data

The Diagnostics button is near the middle of the Channel GUI. Click this button to show diagnostics on this section of the GUI (Figure 2.4). The Diagnostics list shows each diagnostic that has been issued by a controller, repeater or other device since the Channel GUI was opened. New diagnostics will be displayed with red text until they are cleared. Each diagnostic in the list contains the following information:

- **System**: The system on which the diagnostic occurred.
- **Zone**: The zone on which the diagnostic occurred.
- **Site**: The site on which the diagnostic occurred.
- **Device**: The type of diagnostic, such as a fan failure.
- **Position**: The channel number on which an error occurred.
- **Condition**: The condition of the reported device.
- **Timestamp**: The date and time this diagnostic was received.
- **Hardware**: Equipment from which the diagnostic was reported (Repeater # for a repeater-based diagnostic or Channel for a timeslot-based error).
- **Count**: The number of times this diagnostic packet was received.

![Diagnostics List](image)

**Figure 2.4** – Diagnostics List

Right-clicking on the Diagnostics panel will cause a context menu to be shown with the following options:

- **Print Diagnostics**: Prints diagnostics.
- **Clear Selected Diagnostics**: Clear the selected diagnostics in GW3-TRBO. This option is available only for controller alarms because the controller does not report when they end. This will not affect the alarm state of the controller.
- **Purge Selected Diagnostics**: Removes the selected diagnostics from the panel.
Busies Panel Data

Busy packets are displayed in the *Busies* panel (Figure 2.5) as they are received over the data stream. The following information is shown for each received packet:

- **System**: System on which the busy occurred.
- **Zone**: Zone on which the busy occurred.
- **Site**: Site on which the busy occurred.
- **E**: This column contains a flag indicating if the call was an emergency. If this was an emergency busy, this value will be 1. Otherwise, it will be 0.
- **ID**: Radio ID that initiated the busy call.
- **Talkgroup**: Group, if any, on which the busy call took place.
- **Call Type**: Call type of the busy call. This can be one of the following:
  - Group
  - Private
  - Radio Data
- **Start Time**: Date and time the busy started.
- **End Time**: Date and time the busy ended.
- **Elapsed Time (ms)**: Duration of the busy.
- **Coded**: Flag indicating if the call was coded.
- **Digital**: Flag indicating if the call was digital.
- **Multigroup**: Flag indicating if the call was a multigroup call.
- **Multiselect**: Flag indicating if the call was multiselect.
- **System Wide**: Flag indicating if the call was system wide.

![Busies Panel and Options Menu](image)

**Figure 2.5** – Channel Busies Panel and Options Menu
Busies are shown in the **Busies** panel only if the Alias module is aware of the system, zone and site on which the busy is occurring. For example, if a zone is not listed in the resource tree in Alias, busies occurring in that zone will not be listed in Channel. See the *Alias Module Book* for information on how to enable the dynamic adding of zones and sites. The dynamic adding of resources will allow all busies for the currently selected system to be listed in Channel.

While a busy is in the system’s busy queue, it will show as a red entry in the list. Once the entry leaves the queue, it will become black. The **Active Busies** at the bottom of Channel will be shown in red when there are active busies and black otherwise.

The **Busies** panel can contain a maximum of 1,000 active and completed busy entries. The number of completed busies displayed can be reduced with the slider in the **Busy Panel Options Menu**. Reducing the slider to the minimum value will remove all completed busies and only show active busies.

When the busy list is at maximum capacity, the oldest entries are removed as new busies occur. Busies can also be removed manually or automatically (based on time) by checking the **Remove Busies** option in the **Busy Panel Options Menu** (Figure 2.5). When this feature is enabled, busies will be removed automatically from the busy list after the duration specified by the slider.

Right-clicking on the **Busies** panel will cause a context menu to be shown, with options to print the busies or clear selected busies.

**Color Legend**

The **Color Legend** window (Figure 2.6) shows the current color settings as configured via the **Edit→Colors** menu discussed later in this document. This window is accessed from the **View** menu.

![Color Legend](Figure 2.6 – Color Legend)
Sounds Button

Click this button to toggle sounds on or off as desired (Figure 2.7).

<table>
<thead>
<tr>
<th>Sounds</th>
</tr>
</thead>
<tbody>
<tr>
<td>Busy</td>
</tr>
<tr>
<td>Emergency</td>
</tr>
<tr>
<td>Site Idle</td>
</tr>
</tbody>
</table>

**Figure 2.7 – Sound Options**

There are three available sounds:

- **Busy**: Plays whenever a busy call occurs
- **Emergency**: Plays whenever an emergency call occurs
- **Site Idle**: Plays whenever a site has not had activity for longer than the number of seconds that is set as its idle interval
Menus

View

- **Information Pane**: Toggle visibility of the *Information Pane* on the left side of the Channel GUI.
- **Use Alias Colors**: Channel activity information displayed within each channel can be shown using the colors selected in the Alias GUI for radio IDs and talkgroups, as shown in Figure 2.8.
- **Color Legend**: Toggle visibility of the *Color Legend* window.

![Figure 2.8 – Channel activity shown with the colors specified in Alias.](image)

Edit

- **Global Site Idle Interval**: Determines how long the Channel GUI should wait to provide a visual indication that a site is idle (no activity has occurred for $x$ amount of time) for all sites.
- **Enhancements**: Customizes or optimizes the behavior and appearance of channels. These options can be checked (enabled) or unchecked (disabled) and are global preferences, saved per user session.
  - **Variable Channel Heights**: Allows channel blocks to vary in height based on the call information the user has selected to be shown.
- **Options**: Displays the *Channel Options* window. See the next section for more information.
- **Colors**: Allows for modification of the foreground and background colors of each activity type (Figure 2.9).
Figure 2.9 – Channel Color Configuration

Help

- **Show Help**: Displays the Help document for Channel.
- **About**: Displays information about Channel.
Channel Options
Options are used to further customize how Channel is used. The Channel Options window can be accessed by navigating to **Edit → Options**.

![Channel Options Window](image)

**Figure 2.10 – General Options**

There are several different sections in the Channel Options window that can be accessed by clicking on the appropriate section on the left side of the window. The first section that shows up is the **General Options** section. The following options are available here:

- **General Options**: Visibility options that apply to the Channel GUI.
  - Show Information Pane: Toggle visibility of the Information Pane on the left side of the Channel GUI.
  - Auto-Jump to Active Emergency: Toggle feature for Channel to jump to the site on the current system that has an active emergency.

- **Shortcuts**: Allows you to assign an option that can be toggled to a function key. (The function keys are the F1-F12 keys that are at the top of the keyboard)
  - Toggle Info Pane Visibility: Toggles the Show Information Pane option with the designated key.
  - Toggle Color Legend Visibility: Toggles the visibility of the Color Legend window with the designated key.
  - Toggle Threshold Panel Visibility: Toggles the visibility of the Threshold panel with the designated key. (The Threshold panel is
the pop-up window in the bottom-right corner with the flashing red, amber and green lights.)

- **Toggle Busy Pane:** Toggles the visibility of the Busy panel near the bottom of the Information Pane.
- **Toggle Diagnostic Pane:** Toggles the visibility of the Diagnostics panel in the Information Pane.
- **Toggle Systems Pane:** Toggles the visibility of the Systems panel in the Information Pane.

The second section is the **Activity Area** options. This section controls options for the main portion of the GUI that contains the system, zone, site, and individual channel information. There are individual sections that allow for modification of options that apply specifically to these subsections. The Activity Area node has the following options:

- **Variable Channel Heights:** Allows channel blocks to vary in height based on the call information the user has selected to be shown.

**Zone Options:**

- **Show Zone id/alias label:** Show the ID/alias label of each zone in the Zone Header.
- **Show active resource count:** Show the number of active resources present on the zone in the Zone Header.
- **Show active busy count:** Show the count of active busies occurring on this zone in the Zone Header.
- **Show last activity timestamp:** Show the timestamp of the last call activity that occurred on this zone in the Zone Header.

![Figure 2.11 – Zone Options](image)
Site Options:

- **Show site id/alias label:** Show the id/alias label of each site in the Site Header.
- **Show active resource count:** Show the number of active resources present on the site in the Site Header.
- **Show active busy count:** Show the number of active busies present on the site in the Site Header.
- **Show last activity timestamp:** Show the timestamp of the last call activity that occurred on the site in the Site Header.
- **Show busy duration:** Show the duration of busies that occurred on the site in the Site Header.

Channel Options:

- **Use colors from Alias:** Use the colors that are defined in the Alias module in the presentation of channels.
- **Use channel alias in header:** Displays the alias for the channel instead of the channel number or frequency. This will cause channels to be sorted by their aliases.
**System Activity View**

To show the system activity view, check the box next to a system in the **Systems** panel. This will open the system activity view for that system. The system activity view is made up of the following parts:

**System Header**

The **System Header** (Figure 2.12) shows the following system-level information:

- **WACN:** System ID: WACN and System ID.
- **System Alias:**Alias of the system.
- **Zones:** Adjust settings for all zones in the system.
- **Sites:** Adjust settings for all sites in the system.
- **Last Activity:** Date and time of the last call activity received by the system. This value is based on the system clock, not the packet timestamp.

![System Header](image)

Figure 2.12 – System Header

**Zones Menu**

The **Zones** menu on the **System Header** contains the following options:

- **View:** Allows selection of the summary/detail and wrapped/unwrapped options for all zones within the system.

**Sites Menu**

The **Sites** menu on the **System Header** contains the following options:

- **Hide All:** Hide all channel displays of all sites within the system.
- **Show All:** Show all channel displays of all sites within the system.
- **Sort:** Allows for ascending or descending sorting of sites by number or alias.
- **Font:** Allows for modification of the font used throughout the system.
- **Call Info:** Allows for selection of information to display about activity in all channels within the system.
- **Width:** Allows for modification of all channel widths within the system.
- **Idle Timer:** Allows for setting the idle interval of all sites within the system.

The following options on the **Sites** menu may be disabled when conflicting settings are detected in one or more zones within a system: **Hide All, Show All, Font, Call Info.** Changing the summary view settings on one or more zones may allow use of these options on the **System Header.**
Zone Header

The Zone Header (Figure 2.13) shows the following zone-level information:

- **Hide/Show**: Allows the zone activity area under the Zone Header to be hidden or shown.
- **Zone ID**: ID of the zone.
- **Zone Alias**: Alias of the zone.
- **Sites**: Site-based options menu.
- **Wrap**
  - **On**: Channels/Sites are shown using as many rows as necessary to avoid the use of horizontal scrollbars.
  - **Off**: Channels/Sites are shown on a single row with horizontal scrollbars used as needed.
- **Summary**
  - **On**: Summarizes all channels in all sites under a zone by showing channels (without call info) on sites with an adjustable width.
  - **Off**: Shows all channels (with the selected call info) on sites which span the entire width of the zone activity area.
- **Active Busies**: Number of active busies in this zone. Each site on which a radio is busy will be counted toward this total. For Capacity Plus or Linked Capacity Plus connections, this number will be the count of sites affected by an All Trunks Busy (ATB) condition.
- **Active Resources**: Number of active resources in this zone.
- **Last Activity**: Date and time of the last call activity received by this zone. This value is based on the system clock, not the packet timestamp.

<table>
<thead>
<tr>
<th>Hide</th>
<th>Zone 1, GWS1</th>
<th>Sites</th>
<th>Wrap</th>
<th>Summary</th>
<th>Active Busies 0</th>
<th>Active Resources 0</th>
<th>Last Activity: No Activity Received</th>
</tr>
</thead>
</table>

Figure 2.13 – Zone Header

Sites Menu

The Sites menu on the Zone Header contains the following options:

- **Hide All**: Hide all channel displays of all sites within this zone.
- **Show All**: Show all channel displays of all sites within this zone.
- **Sort**: Allows for ascending or descending sorting of sites by number or alias.
- **Font**: Allows for modification of the font used on channels within this zone.
- **Call Info**: Allows for selection of what information to display about activity in all channels within this zone.
- **Width**: Allows for modification of all channel widths within the zone.
- **Idle Timer**: Allows for setting the idle interval of all sites within this zone.
The following options on the Sites menu may be disabled based on the currently selected view settings: Hide All, Show All, Font, Call Info. Changing the summary view settings may allow use of these options on the Zone Header.

Site Header

The Site Header shows the following site-level information:

- **Hide/Show**: Allows the channel activity area under the Site Header to be hidden (minimized) or shown (maximized).
- **Site ID**: ID of the site.
- **Site Alias**: Alias of the site.
- **Busy Duration**: Length of time a busy has been active.
- **Active Busies**: Number of active busies or ATBs on this site.
- **Active Resources**: Number of active resources in this site.
- **Last Activity**: Date and time of the last call activity received by this site.

**Figure 2.14** – Site Header
Statistics

Right-clicking on a site or zone will open a context menu containing an option to view statistics for completed calls. The QUICK Statistics window (Figure 2.15) cannot be refreshed and does not update itself as activity is received. It displays a snapshot of known statistics for the moment it was opened.

Notes about statistics:

- Multisite calls count as a resource on each site involved. For example, a call that involves two sites in a zone will count as two resources in that zone. Zone level statistics display resource counts to more accurately reflect this information.

- Calls with elapsed times of zero will be counted as Calls/Resources on the Summary tab, but will not appear on the Details tab.

- For a Connect Plus or TRBO ATIA input, the duration of a call is the time used by the entire session.

![Figure 2.15 – QUICK Statistics Window](image)
The *QUICK Statistics* window is divided into the following three tabs:

- **Summary**: Gives a high-level view of some commonly requested statistics at the channel and site level. Channels are added to statistics when the Channel module is notified of their existence.
  - **Channel statistics**
    - **Statistics Start Time** – The start time of the statistics for this channel.
    - **Current Time** – The time that the statistics were requested.
    - **Total Available Seconds** – Length of time the channel has been known multiplied by the slot count. For site and zone statistics, this will be the time since the first channel was known. Thus, if all four slots have been used on a MOTOTRBO system with two repeaters, a 15-second interval would display 60 available seconds.
    - **Slots** – Number of slots. The control slot for a Connect Plus or Capacity Max site will be subtracted from this count if the site has generated a *Current Control Channel* packet since the GW3-TRBO service started.
    - **Percent Usage** – Percent of time the channels have been in use since they were known. Calculated by dividing Total Airtime by Total Available Seconds.
  - **Site statistics**
    - **Statistics Start Time** – The start time of the statistics for this site.
    - **Current Time** – The time that the statistics were requested.
    - **Total Busies/Total Busy Resources** – Number of busies or busy resources.
    - **Average Busy** – Average length of a busy.
    - **Longest Busy** – Longest busy recorded.
- **Details**: Shows a list of the previously mentioned statistics where values for each are logged every five minutes the GW3-TRBO service is running. Call/Resource counts reflect the number of calls that were active in that interval. If a single call spans two intervals, it will count as one call in each.
- **Graphs**: Shows a graph of the previously mentioned statistics, charted over time, in five-minute increments.
When opened at the site level, values found in the Channel Statistics section on the Summary tab represent the combined statistics for all channels within the site and values found in the Site Statistics section represent the statistics for the site. When opened at the zone level, values found in the Channel Statistics section on the Summary tab represent the combined statistics for all channels within all sites within the zone and values found in the Site Statistics section represent the combined statistics for all sites within the zone. These statistics are only gathered while the GW3-TRBO service is running. All accumulated statistics are lost and cannot be recovered if the service is restarted.
Site Idle Interval

The site idle interval determines how long the Channel GUI should wait to provide a visual indication that a site is idle (no activity has occurred for \(x\) amount of time).

Site idle intervals can be set at the following levels in the hierarchy:

- **Global**: All sites within all systems.
- **System**: All sites within the currently selected system.
- **Zone**: All sites within the currently selected zone.
- **Site**: The currently selected site.

The global site idle interval can be set under the main menu by navigating to **Edit → Global Site Idle Interval**.

Right-clicking on a system, zone, or site shown on the right in Channel will provide an option for setting the system-wide, zone-wide or site-specific site idle interval, respectively, as shown in Figure 2.16.

![Figure 2.16 – Site Idle Interval option](image)

The desired interval can then be entered into the **Idle Interval** window, shown in Figure 2.17.

![Figure 2.17 – Idle Interval Window](image)

A site’s idle state is indicated via the **Site Header**, which turns solid yellow, as shown in Figure 2.18.

![Figure 2.18 – A yellow site, indicating it is idle](image)
Channel Activity

The channel activity area (Figure 2.19) shows real-time channel-based activity as it occurs.

<table>
<thead>
<tr>
<th>Channel 10</th>
<th>Channel 10</th>
<th>Channel 11</th>
<th>Channel 11</th>
</tr>
</thead>
<tbody>
<tr>
<td>⬤</td>
<td>⬤</td>
<td>⬤</td>
<td>⬤</td>
</tr>
<tr>
<td>Boggs</td>
<td>Boggs</td>
<td>Boggs</td>
<td>Boggs</td>
</tr>
<tr>
<td>Police</td>
<td>Fire Dept</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>0:02</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 2.19 – Channel Activity Area

Channel block headers are color-coded to indicate which channels are involved in a call across multiple sites. If a call is being sourced from the site being viewed, the @ symbol will appear on the right in the channel header, as seen in Figure 2.20:

Figure 2.20 – Channel Header

The body of each channel block is colored according to the type of activity it is handling and corresponds to the Color Legend. Channels that do not contain any text in the body have not yet received activity.

Radio Commands

The following radio commands are “flashed” on the associated channels for about 200 milliseconds as they occur:

- Call Alert
- Radio Check
- Selective Inhibit
- Cancel Selective Inhibit
- IP Console Inhibit
- Cancel IP Console Inhibit
- Ring (Private Call Request)
**Slotted Activity**

MOTOTRBO uses a multiplexing method known as Time Division Multiple Access (TDMA) to divide each 12.5 kHz frequency into two 6.25-kHz-equivalent slots. When connecting GW3-TRBO to the repeaters with an IP connection, each channel will be divided into multiple slots. This will be represented in the Channel GUI by an additional block for each slot. A number to the right of the channel identifier will indicate the slot number, as shown in Figure 2.20. *Note: RF connections will show each slot as its own channel block.*

When Channel loads a site, it will display slot blocks based on the number of slots specified for the channel in the Alias module. Additional slot blocks will be shown if call activity occurs on those slots. If a channel displaying multiple slots receives activity that spans the entire channel, the channel will be temporarily recombined into one extra-wide channel block, as shown in Figure 2.21 below.

![Figure 2.21 – Diagnostic affecting both slots of a TDMA-capable channel](image)

The lower-right corner of the channel block will show either an “A” for analog or “D” for digital (Figure 2.22). This icon’s coloration will change based on the security type of the activity: Coded activity will have a blue background and white lettering, while clear activity will have a white background and blue lettering.

![Figure 2.22 – Digital Indicator](image)

**Data Revert**

Channels marked as Data Revert in the Alias module will be displayed as shown in Figure 2.23. Capacity Max channels marked as single-slot data revert in the Alias module will have only the Slot 2 block marked as data revert. Activity on these slots will be shown if it has a duration.

![Figure 2.23 – Data Revert Channel](image)
**APM Data Supplementation**

Channel can display transmit and receive channel information reported from an APM device. (See the *Connect Module Book* for more information on APM device connections.)

- While the APM reports a channel as transmitting, the transmit level is shown in white text with a green background (see Channel 7 in Figure 2.24).
- While the APM reports a channel as not transmitting, the transmit level is shown in green text with a gray background (see Channel 6 in Figure 2.24).
- While the APM reports a channel as receiving, the receive level is shown in white text with a dark blue background (see Channel 6 in Figure 2.24).
- While the APM reports a channel as not receiving, the receive level is shown in dark blue text with a gray background (see Channel 7 in Figure 2.24).

![Figure 2.24 – APM Data Supplementation](image)

Channel shows a red alarm bell (Clock) on the bottom-left of channels whose last report indicated one or more APM alarms. APM alarms include:

- Antenna Isolation Loss Fail
- Combiner Insertion Loss Fail
- Receive Power Level Fail
- Transmit Power Level Fail
- VCO Lock Fail
- VSWR Fail

Receive values are shown in Channel only if your license includes the *ProcessRssiPackets* restriction under Channel.
**Systems with large numbers of channels**

Systems with more than 2,000 channels can experience Windows resource issues in the Channel module. If this occurs, GW3-TRBO will display an error stating that window handles could not be created.

If this error occurs, you may need to reconfigure the Windows registry to allow more resources. Contact your local IT Department or Genesis Support to modify the following value:

```
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Windows\USERProcessHandleQuota
```

The default value of 10,000 can be increased to a maximum of 18,000.

Only a system administrator should edit the Windows registry. Microsoft has posted the following warning: Serious problems might occur if you modify the registry incorrectly by using Registry Editor or by using another method. These problems might require that you reinstall the operating system. Microsoft cannot guarantee that these problems can be solved. Modify the registry at your own risk.
Packet Information Window

It is possible to view additional information about a call or event by double-clicking on any channel that has received activity.

![Packet Information Window](image)

**Figure 2.25 – Packet Information Window**

The *Packet Information* window provides a list of all information GW3-TRBO has about the current (or last known) activity for the channel.

A channel with a control indicator that receives activity will return to displaying the control indicator once that activity ends. Double-clicking the channel will display the information for the last activity received.
Threshold Lights

Threshold lights will flash when Channel receives a message from the Trigger module regarding a threshold that has been reached. Only threshold alerts involving groups in the current user’s attachment list will be displayed. Depending upon how the threshold is set up, the red, amber or green light will flash. Clicking on one of the three lights will open the Threshold Alerts panel (see Figure 2.26).

![Threshold Alerts panel](image)

**Figure 2.26** – Threshold Alerts panel without any filtering enabled

Example Thresholds

Threshold triggers are created in Trigger and can be configured to alert users to a wide range of conditions. The following example would alert users to the absence of call activity.

*On the lack of 1 occurrence within 10 minutes of PTT events, trigger this red/amber/green light using the color amber.*

The light color should be used to indicate the severity of a trigger, and since it’s possible for the previous condition to arise within a fully operational site the amber threshold color has been selected. The next example shows a trigger that causes the red threshold light to flash when more than 5 busies occur in less than 1 minute.

*On the presence of 5 occurrence(s) within 1 minute of Busy events, trigger this red/amber/green light using the color red.*

See the *Trigger Module Book* for information about other triggers, detailed setup options and more examples.
Threshold Alerts panel

The *Threshold Alerts* panel lists all thresholds that have been reached and allows the thresholds to be filtered by color. Color corresponds to severity, where green indicates a normal priority and red indicates the highest priority. Each item listed contains the timestamp of when the threshold was reached and its description. Items will be displayed in bold until acknowledged.

Single-clicking on an item in the list will acknowledge the alert. If a trigger is based upon a threshold event, double-clicking on its threshold alert item in the alert panel will reposition the activity view of Channel to show the site on which the activity was initiated. Alerts of a certain color can be filtered out by turning off the filter lights at the top of the *Threshold Alerts* panel. Click the X button at the top right of the panel to close it.